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1 Notes about this Documentation 
 

 

 

 
Keep this documentation! 
The operating instructions are part of the product and shall be kept for the entire 
lifetime of the device. They shall be transferred to each subsequent owner or user 
of the device. Care must also be taken to ensure that any supplement to these 
instructions are included, if applicable. 

 
 

1.1 Validity of this Documentation 
This documentation is only applicable to the telecontrol module 761-210 
(Telecontrol Module Compact). 

 

1.2 Copyright 
This Manual, including all figures and illustrations, is copyright-protected. Any 
further use of this Manual by third parties that violate pertinent copyright 
provisions is prohibited. Reproduction, translation, electronic and phototechnical 
filing/archiving (e.g., photocopying) as well as any amendments require the 
written consent of WAGO Kontakttechnik GmbH & Co. KG, Minden, Germany. 
Non-observance will involve the right to assert damage claims. 
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1.3 Symbols 
 

 
  

Personal Injury! 
Indicates a high-risk, imminently hazardous situation which, if not avoided, will 
result in death or serious injury. 

 
 

 

 

 
Personal Injury Caused by Electric Current! 
Indicates a high-risk, imminently hazardous situation which, if not avoided, will 
result in death or serious injury. 

 
 

 
  

Personal Injury! 
Indicates a moderate-risk, potentially hazardous situation which, if not avoided, 
could result in death or serious injury. 

 
 

 
  

Personal Injury! 
Indicates a low-risk, potentially hazardous situation which, if not avoided, may 
result in minor or moderate injury. 

 
 

 
  

Damage to Property! 
Indicates a potentially hazardous situation which, if not avoided, may result in 
damage to property. 

 
 

 

 

 
Damage to Property Caused by Electrostatic Discharge (ESD)! 
Indicates a potentially hazardous situation which, if not avoided, may result in 
damage to property. 

 
 

 

 

 
Important Note! 
Indicates a potential malfunction which, if not avoided, however, will not result in 
damage to property. 
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Additional Information: 
Refers to additional information which is not an integral part of this 
documentation (e.g., the Internet). 

 
 
  



WAGO-TO-PASS® 761 Notes about this Documentation 9 
761-210 Telecontrol Module Compact   

Manual  
Version 2.0.0   

 

1.4 Number Notation 
Table 1: Number notation 
Number code Example Note 
Decimal 100 Normal notation 
Hexadecimal 0x64 C notation 
Binary '100' 

'0110.0100' 
In quotation marks, nibble separated with 
dots (.) 

 
 

1.5 Font Conventions 
Table 2: Font conventions 
Font type Indicates 
italic Names of paths and data files are marked in italic-type.  

e.g.: C:\Programme\WAGO-I/O-CHECK 
Menu Menu items are marked in bold letters.  

e.g.: Save 
> A greater-than sign between two names means the selection of a 

menu item from a menu.  
e.g.: File > New 

Input Designation of input or optional fields are marked in bold letters,  
e.g.: Start of measurement range 

“Value” Input or selective values are marked in inverted commas.  
e.g.: Enter the value “4 mA” under Start of measurement range. 

[Button] Pushbuttons in dialog boxes are marked with bold letters in square 
brackets.  
e.g.: [Input] 

[Key] Keys are marked with bold letters in square brackets.  
e.g.: [F5] 
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2 Important Notes 
 

This section includes an overall summary of the most important safety 
requirements and notes that are mentioned in each individual section. To protect 
your health and prevent damage to devices as well, it is imperative to read and 
carefully follow the safety guidelines. 

 

2.1 Legal Bases 
 

2.1.1 Subject to Changes 

WAGO Kontakttechnik GmbH & Co. KG reserves the right to provide for any 
alterations or modifications that serve to increase the efficiency of technical 
progress. WAGO Kontakttechnik GmbH & Co. KG owns all rights arising from 
the granting of patents or from the legal protection of utility patents. Third-party 
products are always mentioned without any reference to patent rights. Thus, the 
existence of such rights cannot be excluded. 

 

2.1.2 Personnel Qualification 

All sequences implemented on Series 761 devices may only be carried out by 
electrical specialists with sufficient knowledge in automation. The specialists 
must be familiar with the current norms and guidelines for the devices and 
automated environments. 

All changes to the controller should always be carried out by qualified personnel 
with sufficient skills in PLC programming. 

 

2.1.3 Use of the TO-PASS® Telecontrol Modules in Compliance 
with Underlying Provisions 

The TO-PASS® telecontrol modules receive digital and analog signals from 
sensors and transmit and output them to higher-ranking controllers. Additionally, 
it is possible to (pre-)process them. 

The devices have been developed for use in an environment that meets the IP20 
protection class criteria. Protection against finger injury and solid impurities up to 
12.5 mm diameter is assured; protection against water damage is not ensured. 
Unless otherwise specified, operation of the device in wet and dusty environments 
is prohibited. 

 

2.1.4 Technical Condition of Specified Devices 

The components to be supplied Ex Works, are equipped with hardware and 
software configurations, which meet the individual application requirements. 
WAGO Kontakttechnik GmbH & Co. KG will be exempted from any liability in 
case of changes in hardware or software as well as to non-compliant usage of 
components. 
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Please send your request for modified and new hardware or software 
configurations directly to WAGO Kontakttechnik GmbH & Co. KG. 

 

2.2 Disclaimer 
TO-PASS® telecontrol modules communicate using the GSM network (Global 
System for Mobile Communication). Exemptions cannot be made for GSM 
services used by the TO-PASS® telecontrol modules as they may be exposed to 
faults in the service provider’s network. WAGO Kontakttechnik GmbH & Co. 
KG has no involvment with these types of problems. 

Therefore, WAGO Kontakttechnik GmbH & Co. KG will reject any guarantee for 
the implementation of commands transmitted from and received by the TO-PASS® 
telecontrol module. 

 

2.3 Firmware Licensing Terms 

2.3.1 Firmware with Open Source GPL 

The TO-PASS® Compact telecontrol module firmware contains Open Source 
software under GPL. According to Section 3b of GPL, we offer you the source 
code.  
You can obtain the source code with licensing terms of the Open Source software 
from WAGO Kontakttechnik GmbH & Co. KG on request. Send your request to 
support@wago.com with the subject "Open Source TO-PASS Compact". 

  

2.4 Block Rounding for GPRS Connections 
The connection to the provider is established separately for each GPRS data 
transfer up to Firmware Version 2.31 (approx. 1 ... 2 kBytes). As a result, at least 
one block rounding per data transfer is billed. 

Starting from Firmware Version 2.31, a permanent GPRS connection is 
established to the provider. Therefore, data transfers made within the billing 
period (e.g., one day) are summated for block rounding. In the event of continuing 
disturbances in the data transfer, the TO-PASS® telecontrol module will briefly 
interrupt the permanent GPRS connection, which also effects block rounding. 

 
  

mailto:support@wago.com
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2.5 Safety Advice (Precautions) 
 

For installing and operating purposes of the relevant device to your system the 
following safety precautions shall be observed: 

 

 

 

 
Do not work on components while energized! 
All power sources to the device shall be switched off prior to performing any 
installation, repair or maintenance work. 

 
 

 
  

Installation only in appropriate housings, cabinets or in electrical operation 
rooms! 
TO-PASS® telecontrol modules are exposed operating equipment. They may only 
be assembled in housings, cabinets or in electrical operation rooms. Access is 
only permitted via a key or tool to authorized qualified personnel. 

 
  

 
 
 

 

 

 
Use SELV/PELV power source only! 
The TO-PASS® telecontrol module must only be powered from a PELV 
(Protective Extra Low Voltage) or SELV (Safety Extra Low Voltage) power 
source complying with the limited power source (LPS) requirements per DIN EN 
60950-1. 
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Please note the following information about FCC Part 15! 
 
FCC Part 15.19  
This device complies with Part 15 of the FCC Rules.  
Operation is subject to the following conditions: 
1. this device may not cause harmful interference, and 
2. this device must accept any interference received, including interference that 
may cause undesired operation.  
 
FCC Part 15.21  
Modifications not expressly approved by this company could void the user's 
authority to operate the equipment..  
 
Installation by qualified electrician only 
The TO-PASS® telecontrol module must be operated with Antenna 758-0963.  
The antenna gain main not exceed 3 dBi.  
Only qualified staff can install and maintain the TO-PASS® remote module and its 
antenna. The transmitted must be off when working on or nearer to the antenna 
than specified below.  
 
HF-Exposition  
The external antenna operated with the TO-PASS® remote module must be at least 
20 cm away from people. The antenna may not be positioned, so that it works in 
conjunction with any other antenna or transmitter. 

 
 

 

 

 
Hot surface! 
The surface of the housing can become hot during operation. If the device was 
operated at high ambient temperatures, allow it to cool off before touching it. 

 
 

 
  

Do not reverse the polarity of connection lines! 
Avoid reverse polarity of data and power supply lines, as this may damage the 
devices involved. 

 
 

 
  

Replace defective or damaged devices! 
Replace defective or damaged device/module (e.g., in the event of deformed 
contacts), since the long-term functionality of device/module involved can no 
longer be ensured. 
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Protect the components against materials having seeping and insulating 
properties! 
The components are not resistant to materials having seeping and insulating 
properties such as: aerosols, silicones and triglycerides (found in some hand 
creams). If you cannot exclude that such materials will appear in the component 
environment, then install the components in an enclosure being resistant to the 
above-mentioned materials. Clean tools and materials are imperative for handling 
devices/modules. 

 
 

 
  

Cleaning only with permitted materials! 
Clean soiled contacts using oil-free compressed air or with ethyl alcohol and 
leather cloths. 

 
 

 
  

Do not use any contact spray! 
Do not use any contact spray. The spray may impair contact area functionality in 
connection with contamination. 

 
 

 

 

 
Avoid electrostatic discharge! 
The devices are equipped with electronic components that you may destroy by 
electrostatic discharge when you touch. Pay attention while handling the devices 
to good grounding of the environment (persons, job and packing). 
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3 Device Description 
 

3.1 Scope of Delivery 
The scope of delivery of the TO-PASS® telecontrol module, without options, 
includes only the TO-PASS® telecontrol module. Suitable antennas are available 
as accessories. 

 

 

 
SIM Card 
Please note that one SIM card is required to operate each TO-PASS® telecontrol 
module and may be obtained from typical service providers such as T-Mobile, 
VODAFONE or EPlus. WAGO Kontakttechnik GmbH & Co. K.G. is prepared to 
assist with the selection of the most cost-effective tariff for your application. 

 
 

3.2 Use 
The TO-PASS® product family is designed for wireless communication of signals 
and messages. This includes: 

• compact module for the connection of signals from plants, 
• transmission, 
• preparation of values for the operator. 

 

TO-PASS® telecontrol modules 761-210 may be used as: 

• fault indicator, 
• remote data request system, 

 

• telecontrol modules. 
 

The system is connected in wireless mode to PCs, hand computers, Internet PCs, 
mobile telephones, fax, e-mail receivers or land-line telephones. Influences to the 
system are also possible. 

 

Communication occurs using the global mobile radio network “GSM” (Global 
System for Mobile Communication). A SIM card is required for the TO-PASS® 
telecontrol module to use this network. As in the case of a mobile telephone, the 
TO-PASS® telecontrol module requires the SIM card in order to be able to “log 
on” to the network. 

  

When generating a new configuration file, you can select the scope of functions 
based on the available firmware versions, or on the required functionalities. 
Differences between these are shown in the following table. 
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Table 3: Overview of functions 
Functionality 
  
  

FW 2.20 FW 2.31 FW 2.32 FW 2.33 

Module name length 
(Identity) 

8 characters*) 16 characters*) 16 characters*) 16 characters*) 

“Prepaid” request Always active Can be de-
activated 

Can be de-
activated 

Can be de-
activated 

Address length 40 characters*) 60 characters*) 60 characters*) 60 characters*) 
Data transmission to the 
value script 

Standard script SV=01.01 SV=01.01 SV=2.00 

Data transmission to the 
logger script 

Standard script LV=2.00 LV=2.00 LV=2.01 

Address(es) for SMS 
interval 

First address Selectable Selectable Selectable 

Configuring GPS 
settings 

Not possible Possible with 
mobile devices 

Possible with 
mobile devices 

Possible with 
mobile devices 

"Prepaid" request text „*100#“ „*100#“ „*100#“ Parameterizable 
Number check 7 characters*) 7 characters*) 7 characters*) 0 ... 20 

characters*) 
Script version Standard Extended Extended Parameterizable 
Time request script Not 

implemented 
Not 
implemented 

Not 
implemented 

Implemented 

Counter inputs Not supported Not supported Not supported Supported 
Delay time Not supported Not supported Not supported Supported 
Turn-off time Supported to a 

limited extent: 
Supported to a 
limited extent: 

Supported to a 
limited extent: 

Extended 

Resolution of analog 
outputs 

Without decimal 
places 

Without decimal 
places 

Without decimal 
places 

With decimal 
places 

Switched Web interval Not possible Not possible Can be used Can be used 
Setpoint setting via 
Web check-back 

Not possible Not possible Not possible Can be used 

Limited SMS 
transmission 

Not possible Not possible Not possible Can be used 

Acknowledgement text "ACK" "ACK" "ACK" Parameterizable 
MODBUS format Supported to a 

limited extent: 
Supported to a 
limited extent: 

Supported to a 
limited extent: 

Extended 

 
 

No other components are required, other than the SIM card to connect to the GSM 
mobile radio network and a GSM antenna (available as an accessory). Modems 
and interfaces are already installed in the TO-PASS® telecontrol module. 
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3.3 View 
 

 

Figure 1: Front view 

Position Description 
1 SIM Card insert 
2 Antenna connection 
3 Statusindication 
4 PC interface 
5 Connecting terminals for the supply, inputs and outputs 
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3.4 Connectors 
 

3.4.1 Antenna 

The screw connector (SMA socket) for the GSM antenna is located at the top of 
the housing. 

 

Figure 2: Antenna connection 
  

 

 

 
Observe the maximum length of the antenna cable! 
The total length of the antenna cable shall not exceed 30m! The reception quality 
decreases with increasing antenna cable length! 
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3.4.2 Operating Voltage 
 

 

 

 
Use SELV/PELV power source only! 
The TO-PASS® telecontrol module must only be powered from a PELV 
(Protective Extra Low Voltage) or SELV (Safety Extra Low Voltage) power 
source complying with the limited power source (LPS) requirements per DIN EN 
60950-1. 

 
 

Table 4: Terminal assignment for operating voltage 
 

 
Figure 3: Terminal assignment for operating voltage 
 
Connection Short name Designation 
1,2 Uv Operating voltage (+) DC +10 … 30 V 
3, 4 GND Operating voltage (-) DC 0 V, Ground 
38 Shield Enclosure screening, connection of the PE 
 

 

 

 

 
Connect the shield connection to the DIN rail! 
The shield connection of the TO-PASS® telecontrol module (shield, terminal 38) 
must be connected to the DIN rail. The DIN rail must have a low-impedance 
ground (see section "Connections" > "Ground"). 
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3.4.3 Grounding 

3.4.3.1 Framework Assembly 

When setting up the framework, the carrier rail must be screwed together with the 
electrically conducting cabinet or housing frame. The framework or the housing 
must be grounded. The electronic connection is established via the screw. Thus, 
the carrier rail is grounded. 

 

 

 
Ensure sufficient grounding is provided! 
You must take care to ensure the flawless electrical connection between the 
carrier rail and the frame or housing in order to guarantee sufficient grounding. 

 
3.4.3.2 Insulated Assembly 

Insulated assembly has been achieved when there is constructively no direct 
conduction connection between the cabinet frame or machine parts and the carrier 
rail. Here the earth ground must be set up via an electrical conductor accordingly 
valid national safety regulations. 

 

 

 
Recommendation 
The optimal setup is a metallic mounting plate with grounding connection with an 
electrical conductive link with the carrier rail. 

The separate grounding of the carrier rail can be easily set up with the aid of the 
WAGO ground wire terminals. 

Table 5: WAGO ground wire terminals 
Item No. Description 
283-609 1-conductor ground (earth) terminal block make an automatic contact 

to the carrier rail; conductor cross section: 0.2 -16 mm2  
Note: Also order the end and intermediate plate (283-320). 

 
3.4.3.3 Grounding of the TO-PASS® Telecontrol Module 

The shield connection of the TO-PASS® telecontrol module (shield, terminal 38) 
must be connected to the grounded DIN rail. 
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3.4.4 Shielding 

3.4.4.1 General 

Shielding of the data and signal lines reduces electromagnetic interference, thus 
enhancing signal quality. Measurement errors, data transmission errors, and even 
destruction due to excessive voltage can be prevented this way. 

 

 

 
Connect the cable shield to the ground potential! 
Integrated shielding is mandatory to meet the technical specifications in regards to 
measuring accuracy. Connect the cable shield and ground potential at the inlet to 
the cabinet or housing. This allows induced interference to dissipate and to be 
kept away from devices in the cabinet or housing. 

 

 

 

 
Improve shielding performance by placing the shield over a large area! 
Higher shielding performance is achieved via low-impedance connection between 
shield and ground. To achieve this, connect the shield over a large surface area, 
e.g., WAGO shield connecting system. This is especially recommended for large-
scale systems where equalizing current or high impulse-type currents caused by 
atmospheric discharge may occur. 

 

 

 

 
Keep data and signal lines away from sources of interference! 
Route data and signal lines separately from all high voltage cables and other 
sources of high electromagnetic emissions (e.g., frequency converter or drives). 

3.4.4.2 Bus Lines 

The shielding of bus lines is described in the respective configuration guidelines 
and standards for the bus system. 

3.4.4.3 Signal Lines 

 

 

 
Use shielded signal lines! 
Use only shielded signal lines for serial and analog signals. Only then can you 
ensure that the accuracy and interference immunity specified for the respective 
I/O module can be achieved, even in the presence of interference acting on the 
signal cable. 

Signal lines for analog signals must be shielded. The shield for the signal lines 
must be connected to Terminal 38 (Shield) of the TO-PASS® telecontrol module, 
e.g., via the DIN rail. 
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3.4.4.4 WAGO Shield Connecting System 

The WAGO shield connecting system consists of shield clamping saddles, 
busbars and various mounting carriers to enable a wide variety of setups. For 
more information on this, refer to the "Accessories" section of the main catalog. 

   

Figure 4: Example of the WAGO shield connecting system 
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3.4.5 Digital Inputs 
 

 

 

 
Only connect SELV/PELV voltages! 
Only SELV/PELV voltages shall be connected to the device terminals. 

 
 

Table 6: Terminal assignment for digital inputs 

 
Figure 5: Terminal assignment for digital inputs 

Connection Short name Designation 
5 DI1 Digital input 1 
6 DI2 Digital input 2 
7 DI3 Digital input 3 
8 DI4 Digital input 4 
9 DI5 Digital input 5 
10 DI6 Digital input 6 
11 DI7 Digital input 7 
12 DI8 Digital input 8 
 

  

Digital inputs DI1 … DI4 can also be configured alternatively as counter inputs, 
starting from Firmware Version FW 2.33. For more information about 
configuring, refer to the Section "Configuring" > "Counter Inputs". 
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3.4.6 Counter Inputs 
 

 

 

 
Only connect SELV/PELV voltages! 
Only SELV/PELV voltages shall be connected to the device terminals. 

 
  

Digital inputs D1 … D4 can be configured as counter inputs. 
  

Table 7: Counter input pin assignments 

 
Figure 6: Counter input pin assignments 
 
Connection Short name Explanation 
5 DI1 Counter input 1 (configurable) 
6 DI2 Counter input 2 (configurable) 
7 DI3 Counter input 3 (configurable) 
8 DI4 Counter input 4 (configurable) 
38 Shield Shield termination 
 

  

 

 

 
Connect shielding! 
Shielded cables are recommended for the counter inputs.  
When using shielded cables, the shield must be routed to the grounded DIN rail 
(see Section "Connections" > "Shielding"). 
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3.4.7 Digital Outputs 
 

 

 

 
Only connect SELV/PELV voltages! 
Only SELV/PELV voltages shall be connected to the device terminals. 

 
 

Table 8: Terminal assignment for digital outputs 
 

 
Figure 7: Terminal assignment for digital outputs 
 
Connection Short name Designation 
33 DO1 Digital output 1 
34 DO2 Digital output 2 
35 DO3 Digital output 3 
36 DO4 Digital output 4 
37 DO Vcc (+) Voltage for the digital outputs 
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3.4.8 Serial Interface to PC 

Table 9: Serial interface to the PC 

 
Figure 8: Serial interface to the PC 
and MODBUS interface 

Pin Description 
1 Not assigned 
2 TXD 
3 RXD 
4 Not assigned 
5 GND 
6 Not assigned 
7 Not assigned 
8 Not assigned 
9 Not assigned 

 
Table 10: PC interface cable assignment 

WAGO TO-PASS®  PC (D-Sub 9) 
Pin Description Pin Description 
2 TXD  2 RXD 
3 RXD  3 TXD 
5 GND  5 GND 

 
 

 

 
Connecting laptops and PCs without serial interface: 
If the laptop or PC does not have a serial interface, use the USB adapter 761-
9005, which is available as an accessory. 
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3.5 Display Elements 
 

Table 11: Display Elements 

 
Figure 9: Display 
Elements 

Com Busy Run Description 

X X 
Green  
0.5 Hz  

blinking 
Ready to operate 

Green X X Communication via RS232 
interface 

Green  
1 Hz  

blinking 
X X Firmware update 

X Green X 

GSM modem is activated 
- Initialization (takes 

approx. 40 s after system 
start-up if everything is 
OK) 

- SMS/GPRS processing 
- Antenna is not connected 

(the modem is searching 
for a network) 

- Poor GSM network (the 
modem is searching for a 
network) 

X 
Green 
1 Hz 

blinking 
X 

Error in communication with 
SIM card 
- No SIM card available 
- SIM card is defective 

X 
Green 
5 Hz 

blinking 
X 

Serious error in 
communication with GSM 
modem 
- PIN of SIM card in TO-

PASS® parameterization 
is deactivated, but not on 
SIM card 

- Incorrect PIN set on TO-
PASS® 

- SIM card locked 
X: Any state (ON or OFF) 
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3.6 Technical Data 
 

3.6.1 Housing 

Table 12: Technical Data Housing 
Dimensions (W x H x L) 109 mm x 105 mm x 78 mm 
Weight Approx. 412 g 
Operating temperature -20 °C ... +70 °C 
Storage temperature -40 °C ... +85 °C 
Type of mounting DIN 35 rail 
Degree of protection IP 20 
Wire connection Terminal strips (WAGO 250 Series) 

with push-wire connection 
Cross section 0,5 mm² … 1,0 mm²  

AWG 22 … AWG 14 „sol“ 
Stripped length 9 mm … 10 mm 
 

  

3.6.2 Supply 

Table 13: Technical Data Supply 
Operating voltage +10 V ... +30 VDC 
Nominal voltage, operation with mains 
power 

+24 VDC 

Nominal voltage, operation using 
battery 

+12 VDC 

Bias current  
(with +24 VDC power supply, without 
external protective circuit) 

approx. 20 mA 

Current for transmission  
(with +24 VDC power supply) 

< 500 mA 

 
 

3.6.3 GSM Antenna Connection 

Table 14: Technical Data GSM Antenna Connection 
Connection SMA socket 
Cable length (max.) 30 m 
Bandwidth 70 MHz in GSM (850 MHz)  

80 MHz in EGSM (900 MHz)  
170 MHz in DCS (1800 MHz)  
140 MHz in PCS (1900 MHz) 

Gain < 3 dBi 
Impedance 50 Ohm 
Input power > 2 W (peak power) 
VSWR (max.) <= 10:1 
VSWR (recommended) <= 2:1 
 

 



WAGO-TO-PASS® 761 Device Description 29 
761-210 Telecontrol Module Compact   

Manual  
Version 2.0.0   

3.6.4 GSM Communication 

Table 15: Technical Data GSM Communication 
Number of recipients 4 
Recipient types PC, SMS, e-mail, phone, fax 
Communication GSM quad-band 
Communication types SMS (bidirectional),  

telecommunication dial-up connection 
(CSD) 

 
 

3.6.5 Digital Inputs 

Table 16: Technical Data Digital Inputs 
Number of inputs 8 
Input type Type 3 acc. to IEC 61131-2 
Input voltage 0 V ... 30 V DC 
Signal voltage „0“ 0 V … 5 V DC 
Signal voltage „1“ 7 V … 30 V DC 
Input current max. (at 30 V DC) 2.9 mA 
 

  

3.6.6 Counter Inputs 

Table 17: Technical Data Counter Inputs 
No. of counters Max. 4, configurable 
Counter frequency Max. 2000 Hz 
Resolution 32 bits 
Count direction Up/Down 
 

 

3.6.7 Digital Outputs 

Table 18: Technical Data Digital Outputs 
Number of outputs 4 
Output type Semiconductor outputs 
Output current 0.5 A/30 V DC, short-circuit protected 
Type of load Resistive, inductive, lamps 
Energy dissipation Wmax.  
(unique switching off) 

125 mJ;  
Lmax = 2 * Wmax / I2 
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3.7 Approvals 
 

The following approvals have been granted to 761-210 telecontrol modules: 
 

 Conformity Marking 
 
 

 CULUS UL508 
 

 

R&TTE Complaint with 1999/5/EG directive (per Article 3.2) 
  

RoHS Device complies with European RoHS directive. 
 
 

FCC Verification per FCC 15b 
  

Approval, Canada 
 

 

Approval, Croatia 
 

 

Approval, Mexico 
 

 

Approval, Turkey 
 

 

 
 

3.8 Standards and Guidelines 
 

761-210 telecontrol modules meet the following requirements on emission and 
immunity of interference: 

 

EMC CE-Immunity to interference acc. to EN 61000-6-2: 2005 
 

          and acc. to EN 61131-2: 2007 
 

EMC CE-Emission of interference acc. to EN 61000-6-3: 2007 
 

          and acc. to EN 61131-2: 2007 
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4 Mounting 
 

 

 

 
IP20 degree of protection 
The protection class of the TO-PASS® telecontrol module is IP 20. For this reason, 
WAGO Kontakttechnik GmbH & Co. KG recommends mounting in a housing or 
in a switching cabinet. 

 

 

 

 
Ambient temperature -20 °C to +70 °C 
The TO-PASS® telecontrol module is designed for an ambient temperature of -20 
°C to +70 °C.  
In the event of higher or lower temperatures, proper cooling or heating 
arrangements must be provided.  
Please contact WAGO Kontakttechnik GmbH & Co. K.G. for assistance. 

The TO-PASS® telecontrol module is designed to mount on a DIN 35 carrier rail. 

4.1 Mounting the TO-PASS® telecontrol module to the 
DIN rail 

 

Figure 10: Mounting the TO-PASS® telecontrol module to the DIN rail 

1. Place the TO-PASS® telecontrol module on the DIN rail from above. 

2. Press the undersurface against the lower DIN rail edge until the TO-PASS® 
telecontrol module locks into place. 
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4.2 Removing the TO-PASS® telecontrol module from 
the DIN rail 

 

Figure 11: Removing the TO-PASS® telecontrol module from the DIN rail 

1. Press the undersurface against the lower DIN rail edge until the TO-PASS® 
telecontrol module is no longer locked in place. 

2. Remove the TO-PASS® telecontrol module from the DIN rail. 
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5 Connect Devices 
 

5.1 Connecting the Push-wire Connections to the 
Conductor 
The push-wire connections of the TO-PASS® telecontrol modules are designed for 
solid or fine-stranded conductors with cross sections between 0.5 … 1.5 mm² 
(AWG 22 … 14 „sol“). 

 

 

 
Connect only one conductor per clamp! 
Only connect one conductor to each push-wire connection. Do not connect more 
than one conductor at one single connection! 

If more than one conductor must be routed to one connection, these must be 
connected in an up-circuit wiring assembly, for example using WAGO feed-
through terminals. 

Terminate both solid and ferruled conductors without actuation by simply pushing 
them in. For all other conductor types, a suitable operating tool must be used to 
open the push-wire connection for connection. 

 

 

 
Observe strip length! 
When using short ferrules, the retention force of the push-wire connection may be 
reduced. Strip length from 9 to 10 mm must be observed for a safe push-wire 
connection. 

 
1. To open the push-wire connection, use the tool to press the button above the 

connection. 

2. Insert the conductor into the corresponding connection opening. 

3. To close the push-wire connection, release the button. The conductor is 
clamped. 
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5.2 Connection Examples 
 

 

 

 
Connect the shield connection to the DIN rail! 
The shield connection of the TO-PASS® telecontrol module (shield, terminal 38) 
must be connected to the DIN rail. The DIN rail must have a low-impedance 
ground (see section "Connections" > "Ground"). 

 
 

5.2.1 Digital Inputs 
 

 

 

 
Only connect SELV/PELV voltages! 
Only SELV/PELV voltages shall be connected to the device terminals. 

 
  

 

Figure 12: Connection example for switch at input DI1 
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5.2.2 Counter Inputs 
 

 

 

 
Only connect SELV/PELV voltages! 
Only SELV/PELV voltages shall be connected to the device terminals. 

 
  

 

 

 
Connect shielding! 
Shielded cables are recommended for the counter inputs.  
When using shielded cables, the shield must be routed to the grounded DIN rail 
(see Section "Connections" > "Shielding"). 

 
  

 

Figure 13: Connecting example, switching contact at counter input DI1 
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5.2.3 Digital Outputs 
 

 

 

 
Only connect SELV/PELV voltages! 
Only SELV/PELV voltages shall be connected to the device terminals. 

 
 

 

Figure 14: Connection example for a relay at DO1 output 
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6 Commissioning 
  

6.1 Installing the Operating Software 
1. Place the CD with the TO-PASS® operating software in the CD drive of the 

PC.  
 
The "Autostart" function is normally activated on set-up.  
If the set-up program does not start automatically, perform steps 2 to 6. 

2. Close all applications so that the desktop is displayed by the operating 
system. 

3. Move the mouse pointer over the [Start] button of the Windows operating 
system and click the right mouse button. 

4.. Select Windows “Explorer” using a double click 

5. Select the CD drive in which you have placed the CD with the operating 
software. 

6. Start the "WAGO TO-PASS_SETUP(2.17).EXE" program, or a newer 
version in the main directory on the CD. 

7. Follow the menu prompting to choose a default installation path. 
Starting with Version 2.17 of the operating software, the module files and 
exported, logged information are stored in a central directory:  
 
Windows XP 
Documents and settings\All Users\(Common )Documents\  
WAGO Software\WAGO TO-PASS  
 
Windows 7: 
User\Public\Public documents\WAGO Software\  
WAGO TO-PASS 
 
You can save an update file in the "update" subdirectory that can then be 
used for a firmware update. 

8. Installation has been completed successfully when the message "Software 
has been installed successfully" appears. 
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6.2 Starting the TO-PASS® Telecontrol Module 

 

 

 
Do not switch on yet! 
Do not switch on the TO-PASS® telecontrol module until you are prompted to do 
so; do not insert the SIM card for this procedure. 

 

 

 

 
Deactivate the PIN! 
During commissioning, the SIM card may be disabled when an incorrect or 
incomplete PIN is entered. It is therefore recommended that you disable the PIN 
of the SIM card to be inserted. To do this, insert the SIM card in a mobile 
telephone and select the menu option Security > Disable PIN. 

 

 

 

 
Deactivate the call diversion 
Deactivate all call diversions of the SIM card to be inserted to achieve a trouble-
free availability of the TO-PASS® telecontrol module. 

Before using the TO-PASS® telecontrol module it must first be configured with 
the telephone number. 

1. Every TO-PASS® telecontrol module requires an SIM card for proper 
operation. You can obtain an SIM card from any mobile telephone service 
provider. Special data cards are recommended. 

2. Every SIM card contains a telephone number and a PIN code for enabling 
the SIM card to be used in the TO-PASS® telecontrol module.  
 
Always have this telephone number and PIN code on hand. 

3. Connect the PC to the installed TO-PASS® telecontrol module via the serial 
interface. 

4.. If the PC has only USB interfaces, a USB – RS-232 adapter is required. 
Install the driver supplied with the adapter according to the adapter 
manufacturer's specifications. 
A USB adapter is available as an accessory 761-9005. 

5. Start up the PC and then the TO-PASS® operating software. 

6. Select the menu item File > Settings. 

7.Set this as a "RS-232" connection and select the appropriate interface, e.g. 
"COM1". 

8. Then select menu item File > New module. 
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9. When generating a new configuration file, select the firmware version for 
the device that implements the required functionality as the first version in 
the Function selection field.  
The device versions, along with the associated enabling firmware indices 
are displayed to make selection easier.  
In the field Module name enter an identifier for the new device (maximum 
8 places for FW version 2.20, or 16 places for all other firmware versions). 
This identity is the name of your TO-PASS® telecontrol module and serves 
as an identifier. It can only be changed at a later time by completely 
overwriting it. The identifier is also transmitted as an SMS, fax or e-mail in 
the event of an error and should therefore be a typical identifier that is easy 
to associate with the location of use, such as "Tank 1". 

10. A new module will be created at the top left of the screen in the project tree. 
Click on "+" to reveal the rest of the tree. Select the entry "Identity" and 
enter the phone number for the SIM card in the Phone number field at the 
right. In the following line, deactivate the [Use PIN] button, so that the TO-
PASS® telecontrol module does not use the PIN code. Also deactivate the 
PIN on the SIM card! To do this, insert the SIM card into a cell phone and 
under menu item Security select Deactivate PIN. 

11. If the PIN code must be used, activate the [Use PIN] button in the TO-
PASS® operating software and enter the PIN in the field provided. Also 
activate the PIN code for your SIM card using your cell phone. 

12. Switch on the power to the TO-PASS® telecontrol module. The "Busy" LED 
will begin flashing shortly after this. 

13. In the operating software select the menu item Edit > Write parameters. 
The operating software now transmits the parameters to the TO-PASS® 
telecontrol module. 

14. Wait until transmission is complete and the "COM" LED goes out. 

15. Switch off the TO-PASS® telecontrol module. 

16. Use a pointed object (e.g., screwdriver) to carefully slide the SIM card into 
the SIM slot of your TO-PASS® telecontrol module until it locks into place. 
The SIM card is then positioned 2 mm within the enclosure.  
The SIM card can be released by pressing on it again. 

17. Switch the TO-PASS® telecontrol module on again and wait until the 
initialization phase is completed. Initialization is completed when the 
"Busy" LED goes out. 

18. Your TO-PASS® telecontrol module is now ready for use and can be 
configured. Follow the instructions given in the Section "Configuration" for 
this. 
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6.2.1 Parameterizing 
  

6.3 General Settings 
Select the menu item File > Settings for making general settings, such as type of 
connection, interface or language for the TO-PASS® operating interface. 

 

Figure 15: General settings 

Table 19: General settings 
Connection 
RS-232 / GSM /  
Analog / ISDN 

Select the type of connection for communicating with the 
TO-PASS® telecontrol module: 
RS-232  Direct connection via RS-232 cable 
GSM  Dial-up using GSM modem on the PC 
Analog  Dial-up using analog modem on the PC 
ISDN  Dial-up using ISDN modem on the PC 

Modem init. If the connection is to be established via a modem and this 
modem requires initialization, enter the initialization string in 
this field. 

Area code If this connection is to be established via a modem at an 
analog or ISDN PBX and a trunk code is required for this, 
enter the trunk code in this field. 
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Table 19: General settings 
Interface 
COM1 ... COMx Here, select the serial interface where the communication 

cable is connected with a RS-232 connection. 
Language 
English /  
German /  
French 

Select the langauge for the TO-PASS® operator interface here. 

 
To apply the settings and close the dialog window, click [Save]. 

To close the dialog window without applying the settings, click [Cancel]. 
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6.4 Reading Parameters from the Module 
After you have set the type of connection for communicating with the TO-PASS®  
telecontrol module, you are then able to read out the parameters of the connected 
module. 

Select the menu option Edit > Read Parameters. The software then reads out all 
the parameters of the TO-PASS®  telecontrol module. 

Then you can adapt the parameter according to your requirements. 
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6.5 Identity 
Select the TO-PASS® telecontrol module to be configured from the project tree; 
under it, select the Identity option.  
On the right side you will find the selection field for the function, the display field 
for the name, the input field for the telephone number, buttons and input fields for 
the PIN, roaming and prepaid and the input field for the alarm counter. 

 

Figure 16: Configuring the identity 
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Table 20: Configuring the identity 
General 
Function selection You can redifine the firmware version in this selection field, 

that is to say the available scope of functions (e.g., to ensure 
compatibility with devices already in use).  
When you define an older firmware version a check is first 
conducted to determine whether the settings made for this 
version can be used. 

Name The module name of the TO-PASS® telecontrol module is 
displayed in this field. The module name is assigned when a 
new module is set up and can only be changed later by 
overwriting it with a new identity (not via a modem 
connection). 

Phone number In this field enter the phone number of the SIM card used in 
the module. 

PIN To use the PIN number of the installed SIM card, click the 
[Use PIN] button and enter the PIN number in the field 
provided. 

Roaming Roaming is always activated in TO-PASS® telecontrol 
modules.  
To select a favorite carrier, click the [Allow] button and enter 
the 5-digit carrier ID in the field provided. The telecontrol 
mode will then always attempt to use this favorite carrier 
while roaming. 

Prepaid Click the [Poll] button to transmit information with the data 
telegram to a prepaid card that you use. In the input field 
enter the 5-digit polling code, e.g., "*100#" to determine your 
remaining balance. Entering of a polling code is possible 
starting with Firmware Version FW 2.33. 

Alarm counter Enter the maximum value in this field to limit the number of 
alarms transmitted by the TO-PASS® telecontrol module each 
hour.  
If, in the event of a failure (e.g., loose connection), the 
maximum number is exceeded, alarms will no longer be sent.  
The alarm counter can be reset by an SMS being sent to the 
TO-PASS® telecontrol module with the text "RESET", or by 
switching the TO-PASS® telecontrol module off and then on 
again.  
Enter a value of "0" to deactivate limiting. 
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6.6 Addresses 
The TO-PASS® telecontrol module can communicate with a maximum of four 
transmitters/receivers via GSM. Messages are sent by the TO-PASS® telecontrol 
module as SMS; however, they can also be sent as an e-mail, fax or voice mail, as 
defined in configuration.  
The TO-PASS® telecontrol module can also transmit messages to an Internet 
address. 

Select the TO-PASS® telecontrol module to be configured from the project tree 
and the option Addresses.  
The input fields for the addresses are on the right side: 

 

Figure 17: Configuring the addresses 
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Table 21: Configuring the addresses 
Phone/Fax/Mail 
Address 1 ...  
   Address 4 

Enter the target addresses in these fields: 
 
Transmission as SMS:  
Enter the mobile phone number of the recipient.  
Click the button [T2T] when the SMS recipient is also a TO-
PASS® telecontrol module, e.g., when alarm messages are to 
be used as switching commands in the other TO-PASS® 
telecontrol module. 
 
Transmission as e-mail:  
First, enter the e-mail identifier for the provider of the SIM 
card being used. The following identifiers may be used:  
 
- T-Mobile:  8000  
- VODAFONE:  3400  
- E-Plus   7676245.  
 
Enter a comma (,) after this identifier, followed by the e-mail 
address, e.g., for a T-Mobile SIM card:  
 "8000,receiver@provider.net". 
 
Transmission as fax:  
Follow the instructions from the provider for transmissions as 
fax messages. For T-Mobile or Vodafone, for example, enter 
the identifier "99" directly in front of the fax number:  
 
 "99057123456789". 
 

Number 
check 

In this field enter the number of digits to be used for number 
checking. If the entered number is longer than the number of 
digits entered in this field the last digits of the number will be 
checked.  
 
This function is available starting with Firmware Version FW 
2.33. 

 

 

 
Address allocation is only possible when 
number checking is activated! 
Incoming SMS messages cannot be allocated to an 
address in the memory when number checking is 
not active, meaning, for example, that standby is 
not possible. If there are delays in responding when 
number checking is not activated, the target 
address may be overwritten by a new SMS. 
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Table 21: Configuring the addresses 
Online 
Host address In this field enter the host address for the Web portal for test 

purposes, e.g., "www.to-pass.com". 
Host port In this field enter the port for the Web portal (e.g., "80" for 

most http applications) 
Script (value), 
for transmitting 
alarms and status 
messages 

In this field enter the script name for data transmission, for 
test purposes, e.g., "wago/saveTO-PASS.php".  
The "saveTO-PASS.php" script checks the version 
indications from transmitted data and forwards this 
information to the processing script. Script (Logger), 

for transmitting 
the data of the 
logger 
APN access* In this field enter the APN access point (Access Point Name) 

for the SIM card provider, e.g.,: 
 
 T-Mobile:  "internet.t-mobile" 
 Vodafone:  web.vodafone.de (The specified APN 

is not valid for prepaid cards.) 
 

User name* In this field enter the user name for SIM card provider access 
point, e.g.,: 
 
 T-Mobile:  Entry required, content - any 
 Vodafone:  any 
 

Password* In this field enter the password for the SIM card provider 
access point, e.g.,: 
 
 T-Mobile:  Entry required, content - any 
 Vodafone:  any 
 

Script version Use this button to select the script version to define the 
information that is to be transmitted to the Web portal. 

* The examples for APN access, user name and password comply with the 
information valid at the time this manual was written. The required entries can be 
found in the current documentation of your SIM card provider. 

 
  

http://www.to-pass.com/
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6.7 Configuring Inputs and Outputs 
  

6.8 Digital Inputs 
Select your TO-PASS® telecontrol module from the left side of the project tree 
using the identifier. Select the input to be configured under Digital Inputs. 

Digital inputs 1 … 4 can be configured as counter inputs starting from Firmware 
Version FW 2.33. 
The counters count up or down from the given starting and end value. 
With upward counting, exceeding of two counter values can be reported. 
With downward counting, transgression of two counter values can be reported. 

The parameters of the input are given on the right side.  
The buttons and input fields for digital inputs 1 … 4 and 5 … 8 (when provided) 
are identical: 

 

Figure 18: Configuring digital inputs 1 … 4 
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Figure 19: Configuring digital inputs 5 … 8 (when provided) 

Table 22: Configuring of digital inputs 
Counters (only for digital inputs 1 … 4) 
Counters Check this box to use the selected digital input as a counter 

input.  
To activate the counter click the button [Activate]. This 
button is only active when the input is used as a counter 
input. On completion of configuration, the counter can be 
activated/deactivated during operation via the visualization 
system.  
 
 
This function is available starting with Firmware Version FW 
2.33. 

Starting value In this field enter the starting value for the counter.  
This field is only active when the input is used as a counter 
input. 

End value In this field enter the end value for the counter.  
This field is only active when the input is used as a counter 
input.  
If the starting value is less than the end value the counter will 
count upward. If the end value is exceeded, the counting 
process is restarted from the starting value.  
If the starting value is greater than the end value the counter 
will count downward. If counting then continues below the 
end value, the counting process is restarted from the starting 
value. 
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Table 22: Configuring of digital inputs 
Alarm settings 
First value Check this box to have a message sent when the first limit is 

exceeded for upward counting or when the first lower limit is 
violated for downward counting.  
In the field provided, enter the first limit for which a message 
is to be sent when this limit is violated (upper/lower limit) 
(see below).  
The check box and the input field are active only when the 
input is used as a counter input. 

Activation text In this field enter the text to be contained in the message 
transmitted when the digital input has been set, or when the 
counted value has violated the first limit. 

Address Use this button to select the addresses to which the message 
is to be transmitted when the digital input has been set, or 
when the counted value has violated the first limit. 
Click the button [Internet] for applications with GPRS 
transmission.  

Analog value Use these buttons to select up to four analog values which 
can also be transmitted with the message when the digital 
input has been set, or when the counted value has violated the 
first limit. 

Delay time In these fields select the time (in hours, minutes and seconds) 
by which the message is to be delayed after setting of the 
digital input.  
If the input is reset before the defined delay period elapses, 
no activation/deactivation message will be sent.  
Enter "00:00:00" in this field to deactivate this function. The 
message will then be sent immediately.  
This function is available starting with Firmware Version FW 
2.33.  
The selection fields are active only when the input is used as 
a digital input. 

Second value Check this box to have a message sent when the second limit 
is exceeded for upward counting or when the second lower 
limit is violated for downward counting.  
In the field provided, enter the second limit for which a 
message is to be sent when this limit is violated (upper/lower 
limit) (see below).  
The check box and the input field are active only when the 
input is used as a counter input. 
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Table 22: Configuring of digital inputs 
Deactivation text In this field enter the text to be contained in the message 

transmitted when the digital input has been reset, or when the 
counted value has violated the second limit. 

Address Use this button to select the addresses to which the message 
is to be transmitted when the digital input has been reset, or 
when the counted value has violated the second limit.  
Click the button [Internet] for applications with GPRS 
transmission.  

Analog value Use these buttons to select up to four analog values which 
can also be transmitted with the deactivation message when 
the digital input has been reset, or when the counted value 
has violated the second limit. 

Delay time In these fields select the time (in hours, minutes and seconds) 
by which the message is to be delayed after resetting of the 
digital input.  
If the input is set again before the defined delay period 
elapses, no activation/deactivation message will be sent.  
Enter "00:00:00" in this field to deactivate this function. The 
message will then be sent immediately.  
This function is available starting with Firmware Version FW 
2.33.  
The selection fields are active only when the input is used as 
a digital input. 
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6.9 Multiplex Input 
You can configure digital inputs DI1 ... DI4 as multiplex inputs. These four inputs 
will then additionally be read in as a combination and intepreted as a binary 
number. The following applies in this case: 

 DI1 = 20 = 1, 
 DI2 = 21 = 2, 
 DI3 = 22 = 4 and 
 DI4 = 23 = 8. 

Thus, for example, if DI1 and DI3 are set, then the binary number is 5. If only DI4 
is set, then the binary number is 8. 

In the multiplex table you can define an alarm message for each of the 16 statuses 
(0 ... 15). The recipients of the messages can be selected using the multiplex 
settings. 

 

 

 
Counter inputs cannot be evaluated as multiplex inputs! 
Counter inputs cannot be evaluated as multiplex inputs, as these inputs cannot be 
set. 
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6.10 Multiplex Settings 
Select your TO-PASS® telecontrol module from the left side of the project tree 
using the identifier. Select the Multiplex Settings option under Multiplex Input. 
The buttons for enabling multiplex operation and the selection of the recipients of 
the analog values to be transmitted are provided on the right side. 

 

Figure 20: Configuring multiplex operation settings 

Table 23: Configuring multiplex operation settings 
Enable/Addresses 
Multiplex 
operation 

Click the button [Use] to enable/disable multiplex operation 
for digital inputs DI1 ... DI4.  
If a status combination of digital inputs DI1 ... DI4 is fulfilled 
in multiplex operation for which a message text has been 
defined, a corresponding message will then be sent (see 
below). 

Address Use this button to select the addresses to which the message 
is to be transmitted when the corresponding status 
combination of digital inputs DI1 … DI4 is fulfilled.  
Click the button [Internet] for applications with GPRS 
transmission.  

Analog value Use these buttons to select four analog values which can also 
be transmitted with the message text when the corresponding 
status combination of digital inputs DI1 … DI4 is fulfilled. 
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6.10.1.1 Multiplex Alarm Text 

Select your TO-PASS® telecontrol module from the left side of the project tree 
using the identifier. Select the Multiplex Table option under the Multiplex Input 
entry. The input fields for the alarm texts pertaining to the 16 statuses are 
provided on the right side. 

 

Figure 21: Configuring multiplex operation alarm texts 

Table 24: Configuring multiplex operation alarm texts 
Alarm texts 
Value 0 ... Value 
15 

In these fields enter the texts to be transmitted in the message 
when the corresponding status combination of digital inputs 
DI1 … DI4 are fulfilled.  
Messages are not sent for status combinations without any 
entries. 
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6.10.2 Digital Outputs 

Select your TO-PASS® telecontrol module from the left side of the project tree 
using the identifier. Select the output to be configured under the entry Digital 
Outputs.  
 
The parameters of the output are given on the right side. The input fields are 
identical for all digital outputs: 

 

Figure 22: Configuring the digital outputs 

Table 25: Configuring the digital outputs 
Settings 
Activation text In this field enter the activation text for the output.  

When the TO-PASS® telecontrol module receives this text as 
an SMS it switches this digital input on and connects the DC 
voltage available at terminal 37 to the corresponding output. 

Deactivation text In this field enter the deactivation text for the output.  
When the TO-PASS® telecontrol module receives this text as 
an SMS it deactivates this digital output and disconnects the 
DC voltage available at terminal 37. 

Turn-off time In these fields select the turn-off time for the output in hours, 
minutes and seconds.  
If the digital output has been activated, it will remain active 
for the time defined here and voltage remains applied at 
terminal 37. When this time elapses, the output switches off 
the voltage at terminal 37 automatically.  
The maximum turn-off time is limited to "00:01:59" up to 
Firmware Version FW 2.33. 
Define a time of "00:00:00" hh:mm:ss to deactivate this 
function. The output will then remain permanently activated 
until the next deactivation message is received. 
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6.11 Configuring Error Detectors 
The TO-PASS® telecontrol module can transmit error messages to a maximum of 
four recipients. The recipients are informed either directly one after another or (if 
configured) after expiration of the time delay for acknowledgment. The message 
is sent by the TO-PASS® telecontrol module as an SMS; however, it can also be 
sent as an e-mail, fax or voice mail. In addition, the error messages can also be 
transmitted to a Web portal. 

 

 

 
Device-dependent Function 
Devices with GPRS functionality (device identifier "Web") are required to 
transmit error messages to a Web portal. 

 

 

 

 
Note the calculation packet size! 
Please note the information given on calculation packet size in the Section 
"Important Information - Rounding of Blocks for GPRS Links." 

 
  

6.11.1 Alarm Messages for Digital Inputs 

If on or off states of digital inputs are to be sent as error messages, select the 
desired recipient for the respective input statuses using buttons [1] ... [4]. Click 
the [Internet] button to also transmit the message to a Web portal.  
In addition, you can also specify the analog values that are to be transmitted along 
with the error message. 

  

6.11.2 Limit Messages for Counter Inputs 

If violations of upper/lower counter limits are to be sent as error messages, 
activate the respective counter value and select the desired recipient using buttons 
[1] ... [4].  
Click the [Internet] button to also transmit the message to a Web portal.  
 
You can also specify the analog values that are to be transmitted along with the 
error message. 
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6.11.3 Acknowledgement 

Acknowledgment is the confirmation that a message has actually been sent to the 
recipient. Select the TO-PASS® telecontrol module from the project tree using the 
identifier. Select the entry Acknowledgment under the option Special Functions.   
The right side contains the input fields for the waiting time, the number of 
repetitions and the response text. 

 

Figure 23: : Configuring the acknowledgment response 

Table 26: Configuring the acknowledgement response 
Settings 
Waiting time In this field enter the time that the TO-PASS® telecontrol 

module waits for an acknowledgement after transmitting an 
alarm SMS.  
Acknowledgement is in the form of an SMS containing the 
configured response text, or a simple call by the recipient to 
the TO-PASS® telecontrol module.  
The TO-PASS® telecontrol module registers the call.  
You then receive an acknowledgement SMS containing the 
identifier, the response text and the alarm text. 

Repetitions In this field enter the number of acknowledgement cycles.  
If no recipient acknowledges the message of the TO-PASS® 
telecontrol module, then the entire cycle can be executed 
again, allowing the TO-PASS® telecontrol module to inform 
the first address once again and to wait for an 
acknowledgment. 

Response text In this field enter the SMS acknowledgement text (up to 20 
characters).  
This input field is available starting with Firmware Version 
FW 2.33. 
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6.11.4 Transmission Repeat Times 

Select the TO-PASS® telecontrol module from the project tree using the identifier. 
Select the entry Repeat times under the option Special Functions.  The input 
fields for the Web interval, the Web outputs and the SMS interval and buttons for 
target addresses are located on the right side. 

 

Figure 24: Configuring the transmission repeat times 
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Table 27: Configuring the transmission repeat times 
Web settings 
Web interval In this field enter the cycle time in minutes to define the 

intervals that the TO-PASS® telecontrol module is to send 
data to the Internet.  
Enter a "0" to deactivate cyclical data transmission.  
The maximum value that you can enter here is 9999 minutes, 
which corresponds to around one transmission per week. 

 

 

 
Device-dependent function 
The function is only available for devices with 
GPRS functionality (device identification "Web"). 

 

 

 
Note the calculation packet size! 
Please note the information given on calculation 
packet size in the Section "Important Information - 
Rounding of Blocks for GPRS Links." 

Switched interval Check this box to have the transmission interval switched as 
a function of the status of a digital input between Web 
interval and switching interval.  
This function is available starting with Firmware Version FW 
2.33. 

Switching input In this field, select a digital input to be used for switching of 
the transmission interval between Web interval (Off status of 
the input) and the switching interval (On status of the input).  
When the status of the switching input changes, the initial 
transmission is triggered, followed by transmission at the 
cycle time defined in the field Switching interval.  
This selection field is active only when the Switched 
interval box is checked.  

 

 

 
Counter inputs may not be defined as switching 
inputs 
Counter inputs may not be used as switching 
inputs, as no status changes are evaluated for these 
inputs. 

Switching interval In this field enter the cycle time in minutes to define the 
intervals that the TO-PASS® telecontrol module is to send 
data to the Internet.  
Enter a "0" to deactivate cyclical data transmission.  
The maximum value that you can enter here is also 9999 
minutes. 

Web outputs Use these buttons to select the inputs whose default setpoints 
can be modified via responses from the Web portal.  
This function is available starting with Firmware Version FW 
2.33. 
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Table 27: Configuring the transmission repeat times 
SMS Settings 
SMS interval Here, enter the cycle time in minutes to define the intervals 

that the TO-PASS® telecontrol module is to send data to the 
addresses defined under Address.  
SMS content is specific to devices and firmware used and is 
described in the Section "Operation – Remote Polling by 
SMS".  
The cyclic SMS can, for example, be used for operational 
supervision. 

Address Use this button to select the addresses to which the message 
is to be transmitted in defined cycles. 

Limited SMS 
transmission 

Check this box to limit the SMS interval to certain days of 
the week and to certain times of day.  
Time adjustment must be performed for limited SMS 
transmission to check the day of the week and the active 
time.  
The first SMS is transmitted when the starting value for the 
active time on an active day is reached. The SMS is also 
transmitted when a cycle time of "0" has been defined. The 
transmission cycle is started when the cycle time is situated 
within the active time.  
This function is available starting with Firmware Version FW 
2.33. 

Active time In these fields you can select the starting and end points for 
the active time in "hh:mm".  
The starting point must be before the end time. A selection 
not in line with these requirements will be adapted 
automatically.  
These selection fields are active only when the box Limited 
SMS transmission has been checked. 

Active days Check these boxes to mark the active days for SMS 
transmission.  
These boxes are active only when the Limited SMS 
transmission box has been checked. 
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6.12 Time Adjustment 
Select the TO-PASS® telecontrol module from the project tree using the identifier. 
Select the entry Acknowledgment under the option Time setting.  The buttons 
for various settings pertaining to time adjustment are located on the right side. 

 

Figure 25: Setting the time adjustment 

Table 28: Setting the time adjustment 
Settings 
Time adjustment The TO-PASS® telecontrol module sends an SMS to itself and 

receives the current time from the provider transmitted by 
this SMS when the [SMS] button is clicked.  Time 
adjustment using an SMS takes place only once when the 
TO-PASS® telecontrol module is restarted, or when an SMS 
with the text "Time" is received.  
When the [Internet] button is clicked, the TO-PASS® 
telecontrol module takes the time from the response by the 
Web portal on each transmission to the Web portal.  
The transmission runtimes may cause time differences to 
occur. 
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6.13 Writing Parameters to the Module 
After you have adapted all parameters for the TO-PASS® telecontrol module to 
your requirements, you have to write the parameters to the connected module. 

Select the menu option Edit > Write Parameters. The software then writes all 
parameters to the TO-PASS® telecontrol module. 

 

After the COM LED goes out, the TO-PASS® telecontrol module is ready for 
operation. 

 
  



WAGO-TO-PASS® 761 Commissioning 63 
761-210 Telecontrol Module Compact   

Manual  
Version 2.0.0   

 

6.13.1 Operation 
 

6.14 Remote Query of Process Values 
The TO-PASS® telecontrol module offers two options for remote inquiry of the 
process values available: 

• Query via SMS 
• Query with the TO-PASS® Operator Program 
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6.14.1 Remote Polling via SMS 

For remote polling via SMS, send an SMS containing the text "State" to the TO-
PASS® telecontrol module.  
The TO-PASS® telecontrol module responds promptly with an SMS to your 
mobile phone containing all of the current process values. 

 

Table 29: SMS format 
Value transmitted: Meaning 
Module 1 Identity 
1001 Condition of the digital inputs 1 ... 4 

(0 = not set, 1 = set) 
0110 Condition of the digital outputs 1 ... 4 

(0 = not set, 1 = set) 
Normal Status Status text or prepaid information (optional) 
AC=99 Alarm counter 

(displays the alarms that are still possible per hour).  
The alarm counter only transmitted when enabled (Alarm 
counter parameter in the Identifier dialog <> "0"). 

 
  

If at least one digital input is configured as a counter input, the counter status is 
added to the SMS. The additional lines are added in front of the "Status text" line. 

  

The counter status shows the last change that has occurred since the last SMS 
transmission, or after a system start (independent of the value and logger status). 

Example: 

Table 30: Items added to SMS for counter inputs 
Value transmitted Explanation 
0 Status counter 1 (no counter) 
e34560000 Status counter 2 (counter active, counter value = 

34560000) 
C10000000 Status counter 3 (counter value changed, value = 

10000000) 
R0 Status counter 4 (counter reset, value = 0) 
 
The counter status may be one of the following statuses: 
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Table 31: Counter status 
Status Explanation 
0 Digital input not configured as a counter. 
e:ZW Counter is active: Counter value. 
d:ZW Counter is not active: Counter value. 
o:ZW Counter overflow: Counter vlaue. 
r:ZW Counter has been reset: Counter value. 
s:ZW Counter has been started: Counter value. 
c:ZW Counter value has been changed: Counter value. 
ZW Counter value 
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7 Remote Polling using the TO-PASS® 
Operating Program 

  

To display the process values with the TO-PASS® operator program, select the 
menu item Visualization > Process values. The program establishes a link to the 
TO-PASS® telecontrol modules selected. Please note the mode used to dial up the 
TO-PASS® telecontrol modules, either via direct RS-232 cable connection or an 
analog ISDN or GSM modem dial-up. The selection is specified in the menu 
option File > Settings. 
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7.1.1.1 Inputs/Outputs 

Press the [I/O] button to display the process values of the inputs and outputs. The 
process values displayed are valid if the on-line display is green. 

 

Figure 26: Visualization of the process values 

Process values pertaining to inputs are displayed in the upper portion of the 
window and those pertaining to digital and analog outputs are displayed in the 
lower portion of the window. 

  

Digital inputs configured as counter inputs are highlighted in blue. 
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7.1.1.2 Counters 

To display the counter process values, click the [Counter] button (possible only 
when inputs have been configured as counters). The process values displayed are 
valid when the on-line indicator is highlighted in green. 

 

Figure 27: Counter process values 

The counter statuses are shown at the top of the window, while the counter values, 
the starting and end values and the limits are shown at the bottom. 
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7.1.2 Telecontrol 

TO-PASS® telecontrol modules offer the option of influencing a process remotely 
with the help of their analog and digital outputs. There are two methods available: 

• Telecontrol via SMS 
• Telecontrol with the TO-PASS® operator program. 
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7.1.3 Telecontrol via SMS 
  

7.1.4 Setting or Resetting a Digital Output 

To set or reset a digital output, send an SMS with the text that is entered under 
Activation text or Deactivation text for the output to the TO-PASS® telecontrol 
module.  The TO-PASS® telecontrol module acknowledges the command with an 
SMS containing the identifier and the transmitted text. 

Example: 

Table 32: Example of parameters for Set DO 
Parameter Setting 
Activation text DOUT1=1 
Deactivation text DOUT1=0 
Turn-off time 00:00:00 
 
Send an SMS with the text "DOUT1=1" to the TO-PASS® telecontrol module to 
switch on output 1. The TO-PASS® telecontrol module acknowledges the 
command with an SMS with the identifier and the text "DOUT1=1 OK!". 

Send an SMS with the text "DOUT1=0" to the TO-PASS® telecontrol module to 
switch off output 1. The TO-PASS® telecontrol module acknowledges the 
command with an SMS with the identifier and the text "DOUT1=0 OK!"  
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7.1.4.1 Changing the Counter Value or Status 

To change the value or the status of a counter, send an SMS containing the text 
"Counter" and the corresponding control commands (more than one can be sent) 
to the TO-PASS® telecontrol module.  
The control commands identify the counter input and the actual command. 

Table 33: Control commands for counters 
Control command Function 
Cx= (x: 1 ... 4) Select counter 1 ... 4 
E Activate counter 
D Deactivate counter 
R Reset counter 
n (e.g., 500) Set counter value 
 
Control commands must be concluded with a semicolon (";"). 

The TO-PASS® telecontrol module acknowledges the command with an SMS 
containing the identifier and the transmitted text. 

Example: 

To activate Counter 2 and set it to 500, and to also deactivate Counter 3, send an 
SMS containing the text "Counter: C2=E C2=500 C3=D;" to the TO-PASS® 
telecontrol module.  
The TO-PASS® telecontrol module acknowledges the command with an SMS 
containing the identifier and the text "COUNTER: OK!". 
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7.1.4.2 Telecontrol with the TO-PASS® Operator Program 
  

To display the process values with the TO-PASS® operator program, select the 
menu item Visualization > Process values. The program establishes a link to the 
TO-PASS® telecontrol modules selected. Please note the mode used to dial up the 
TO-PASS® telecontrol modules, either via direct RS-232 cable connection or an 
analog ISDN or GSM modem dial-up. The selection is specified in the menu 
option File > Settings. 
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7.1.5 Inputs/Outputs 

Press the [I/O] button to display the process values of the inputs and outputs. The 
process values displayed are valid if the on-line display is green. 

 

Figure 28: Visualization of the process values 

Process values pertaining to inputs are displayed in the upper portion of the 
window and those pertaining to digital and analog outputs are displayed in the 
lower portion of the window. 

  

Digital inputs configured as counter inputs are highlighted in blue. 
 

You can set or reset the digital outputs by pressing the [Set/Reset] buttons. 
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7.1.5.1 Counters 

To display the counter process values, click the [Counter] button (possible only 
when inputs have been configured as counters). The process values displayed are 
valid when the on-line indicator is highlighted in green. 

 

Figure 29: Counter process values 

The counter statuses are shown at the top of the window, while the counter values, 
the starting and end values and the limits are shown at the bottom. 

  

To start a counter, click the button [Activate]. 

To stop a counter, click the button [Deactivate]. 

To restore the counter to its starting value, click the button [Reset]. 

To set a counter to a new value, enter the required counter value in the 
corresponding input field and then click the associated button [Set] to apply the 
new value. 
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7.2 Acknowledging Error Messages 
If a waiting time not equal to 0 has been set for the acknowledgment of error 
messages, the TO-PASS® telecontrol modules expects an acknowledgment of error 
messages from the recipient. 

Acknowledgement is in the form of an SMS containing the configured response 
text, or a simple call by the recipient to the TO-PASS® telecontrol module.  
The TO-PASS® telecontrol module registers the call.  
You then receive an acknowledgement SMS containing the identifier, the 
response text and the alarm text. 

 

 

 
Acknowledgement by phone call is based on the card being used! 
Some data cards do not allow voice links, meaning that acknowledgement is only 
possible via SMS. 

If the message is not acknowledged within the defined waiting time, the TO-
PASS® telecontrol modules sends the error message automatically to the next 
recipient entered under addresses and waits again for the defined waiting time for 
an acknowledgment. 

If none of the defined recipients acknowledge the error message and the number 
of repetitions is not set to 0, then the procedure is repeated either until a recipient 
acknowledges the error message or the maximum number of repetitions has been 
reached. 
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7.2.1 Switching to Standby 

 

 

 
Standby authorization 
Switching standby on and off is only possible by subscribers whose telephone 
number has been entered in the address list! 

Using the "Standby" function, it is optional to change all messages sent by the 
TO-PASS® telecontrol modules specifically to the respective ready state. This 
takes place with simple changeover via SMS. 

To do this, just send an SMS with the text "Standby1" to the TO-PASS® 
telecontrol modules. The TO-PASS® telecontrol module then transmits all alarm 
messages to the SMS sender. Other receivers defined in the TO-PASS® telecontrol 
modules are no longer informed. 

To switch this function off, send an SMS with the text "Standby0" to the TO-
PASS® telecontrol modules. 

The TO-PASS® telecontrol module sends the SMS “STANDBY OK!” at the start 
of the standby function and the “STANDBY END!” at the end of the standby 
function. 
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8 Diagnostics 
 

8.1 Test Inputs and Outputs 
To test the inputs and outputs select the menu option Controller > Test I/O.  
The following window is displayed: 

 

Figure 30: Test inputs and outputs 

The process values of the inputs are displayed in the upper area and the process 
values of the outputs are displayed in the lower area. 

 

By pressing the buttons [Output 1] … [Output 4] in the upper area switch digital 
inputs on and off. 

  

Click [OK] to end the test and close the window. 

Alternatively, the inputs and outputs can also be tested with the help of the menu 
option Visualization > Process values. 
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8.2 Testing the Counter Inputs 
To test the counter inputs, select the menu item Edit > Test counters.  

 

Figure 31: Testing counters 

The counter statuses are shown at the top of the window, while the counter values, 
the starting and end values and the limits are shown at the bottom. 

To start a counter, click the button [Activate]. 

To stop a counter, click the button [Deactivate]. 

To restore the counter to its starting value, click the button [Reset]. 

To set a counter to a new value, enter the required counter value in the 
corresponding input field and then click the associated button [Set] to apply the 
new value. 

Click [OK] to end the test and close the window. 

Alternatively, the counter inputs can also be tested using the menu item 
Visualization > Process values. 
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8.3 Testing the Connection 

 

 

 
Direct serial link required 
The connection may only be tested with a direct serial link to the TO-PASS® 
telecontrol module. 

To test the connection, select the menu option Edit > Test SMS/GPRS. The 
following window is displayed:  

 

Figure 32: Testing the connection 

Select the address to send an SMS to and enter the text to be sent. Click the 
[Send] button to send the message. The status of the transmission is then 
displayed. 

Click [OK] to end the test and close the window. 
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8.4 Testing the Modem 

 

 

 
Direct serial link required 
The modem test may only be performed with a direct serial link to the TO-PASS® 
telecontrol module. 

To test the mode, select the menu item Modem > Test.  
The following window is displayed: 

 

Figure 33: Testing the modem 

A link to the modem is established and the signal strength displayed. 

Click [OK] to end the test and close the window. 
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